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Introduction
This document suggests basic guidelines to help you resolve database connectivity problems that may arise
when using Crystal Reports (CR) XI and Crystal Reports XI Release 2. Often, it is necessary to perform
several different tests and to answer a series of questions to isolate where the issue may exist.
The troubleshooting process recommended in this paper is intended to assist you in narrowing down and
resolving the cause of the behavior that you are experiencing.
When troubleshooting, be sure to note where and when the problem occurs. The break point can indicate
where the problem is happening. If an error message appears at login, this may suggest an authentication
issue or the inability of the driver to obtain a listing of tables or fields. Unexpected database connectivity
behaviors can occur when you initially design a new report, or when you preview/refresh an existing report in
the Crystal Reports designer. In the latter case, an error message may suggest incorrect linking or design
within the report itself.
External factors can affect a successful connection to your database. These factors may include database
permissions, inability of third-party drivers to perform specific queries, network conditions, and more.
Be sure to document the exact text from any error messages that appear, as they are the first hint at
identifying the actual break point of the report.
This document frequently refers to supported platforms documents. Please refer to the supported platform
document for the appropriate product version.

Connection Type Specific Troubleshooting
Crystal Reports is designed to connect to many different types of databases. Each database category has
unique requirements for troubleshooting.
SQL-type Databases
SQL databases generally use a server and client configuration. For successful reporting when connected to
SQL databases
•

the database client software must be installed on the local computer drive

•

a connection through the database client software is possible.

Common SQL-type databases include Oracle, Microsoft SQL Server, Sybase, Informix, IBM DB2, and
Pervasive. For SQL-type connections, you must be able to connect to the database outside of Crystal
Reports. If this does not work, your systems administrator or database administrator may need to configure
your computer.
PC-type Databases
PC databases are generally local to the computer where Crystal Reports are run so the troubleshooting
steps required for PC connections are slightly different from with SQL-type databases. A PC-type connection
requires
•

the database to be installed locally on the computer

•

you to be able to see all of the expected data within the database.

Common examples of PC-Type databases include Microsoft Access, Microsoft Excel, Dbase, Visual FoxPro,
Act!, and Clipper. If you are not able to see all the data within the database itself, then you may not be able
to see this data in Crystal Reports. The issue may be caused by insufficient database access permissions.
Verify with your Database Administrator that your logon information has sufficient permissions and rights.
ODBC Connections
ODBC connections are the most common types of connections used with Crystal Reports. Even if you are
using a different type of connection, try changing to an ODBC connection to troubleshoot connectivity issues.
Doing so will help you to identify where the break in the report is occurring.
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For ODBC connections you can download the SQLCON32 testing utility to help determine if there is an issue
with the access permissions or the ODBC driver, separately from Crystal Reports. SQLCON32 offers the
ability to test the connection, to obtain a list of tables, views, and stored procedures, to get a list of fields, and
to retrieve data.
OLE DB Connections
OLE DB connections can be tested by other means. If there is a possibility that an OLE DB connection is
failing outside Crystal Reports, check
•

the database permissions of your user name

•

a third-party product’s ability to connect to the OLE DB driver

•

the Microsoft Data Access Components layer.

Your database administrator can advise you on your database permissions. Both permissions and the ability
to retrieve data through the OLE DB driver can be verified with a third-party application like QTADO.
It is also possible to determine if the OLE DB data provider is currently installed or configured properly on
your computer by creating a universal data link file (UDL or .udl file). In a text editor, create a new file and
save it as “filename.udl”. Then double click the UDL file. This will launch an OLE DB Provider dialog, listing
the driver being used in the report. If the driver does not appear, then it is possible there is something wrong
with the database installation, or with the Microsoft Data Access Component (MDAC) layer that is installed
with some Microsoft products. For more information about MDAC, refer to Microsoft article 842193.
JDBC Connections
Crystal Reports 10 is the first version able to make database connections using Java Database Connectivity
(JDBC). Crystal Reports, however, is not able to make connections with all JDBC drivers. Supported JDBC
drivers are listed in the Supported Data Sources for Crystal Reports section of the supported platforms
document for each version of Crystal Reports.
Checking the JDBC Connection Outside of Crystal Reports
When trying to make a JDBC connection if it appears that the driver class is not being recognized or that the
JDBC settings are not configured properly then try testing the JDBC connection outside Crystal Reports. See
SAP Note 1218714, “Troubleshooting JDBC (JNDI) connection issues with Crystal Reports” for a description
of steps for testing the permissions and the ability to retrieve data through a JDBC connection outside
Crystal Reports. The test in SAP Note 1218714 will verify the settings for the driver class name, the JDBC
URL, and the user permissions for running a query.
Checking the CRConfig.xml file
The CRConfig.xml file stores the JDBC connection information for Crystal Reports. Once a JDBC connection
and query are successful outside Crystal Reports, compare the verified driver class name, JDBC URL, and
user login information with these settings contained in the CRConfig.xml file.
For Crystal Reports XI, the CRConfig.xml file is at C:\Program Files\Common Files\Business
Objects\3.0\java.
For Crystal Reports XI Release 2, the CRConfig.xml file is at C:\Program Files\Business
Objects\Common\3.5\java.
If the driver class name, JDBC URL, and user login information appear to be correct, check the <JavaDir>
element in the CRConfig.xml file. The path for the <JavaDir> should reference the bin folder for your Java
SDK or JRE. Ensure the path listed inside <JavaDir> actually exists.
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If Only Command Objects are Available
Sometimes, only partial connectivity is possible with certain JDBC client driver versions and / or JDBC
vendors. With your current JDBC connection, if you can log in to the database but tables, views, and stored
procedures are not visible, try running a query through JDBC using a command object. After logging into the
JDBC connection, look for the Add Command object under the Connection tab in the Database Expert.
Double-click the Add Command tab and enter a simple SQL statement such as “SELECT * from Table”. If
you are not sure what the syntax should look like you can obtain a sample of SQL syntax for your database
by creating a report using an ODBC connection. Under the database menu, click Show SQL Query to
display the SQL syntax behind the query.
If you can retrieve data with a command object there may be an issue with that JDBC driver version or
possibly even with vendor differences. First, check the supported platforms document for this driver to see if
it is supported for use with Crystal Reports. The supported platforms document may suggest another version
of the driver or it may not list any JDBC driver from this vendor. Next check if any other suitable versions for
the JDBC driver are available. With certain databases, other versions of the client may work.
JNDI Connections
Usually Java Naming and Directory Interface (JNDI) connections make a connection through the same driver
as Java Database Connectivity (JDBC). Crystal Reports will use many of the same settings for JDBC and
JNDI so testing a JDBC with the driver can help to verify items such as permissions and driver class name.
When troubleshooting JNDI, ensure that a JDBC connection is possible from the client where the JNDI
connection is being made. Refer to the steps above under JDBC Connections for troubleshooting.
Native Connections
Native connections rely on the specific versions of the client to be present on the computer where the
connection is being made. To ensure your version of the client is supported, check the supported platforms
guide.
Few third-party test utilities exist for native connections, thus testing options for native connections are
somewhat limited.
To troubleshoot native connections
•

Make sure it is possible to connect to the database server from the database client on a client
workstation.

•

Try switching connections to an ODBC driver or OLE DB driver to verify the server settings,
permissions, and accessibility to the data.

•

Verify that the connection works with another driver. If another driver works but the native driver does
not, the result suggests that there is an issue with the specific driver, the database client version, or
the authentication information given to the native driver.

OLAP connections
Crystal Reports XI and later support access to OLAP data sources through direct connections. A direct
connection requires an installed OLAP client on the same computer where Crystal Reports is installed. The
types of OLAP connection supported are listed in the Server Type drop down of the Connection Properties
dialog. Refer to the supported platforms document to determine if your OLAP server is supported.
Ensure that it is possible to login through the OLAP client. If the login fails, you may try logging in with a
different account. OLAP servers such as Microsoft Analysis Services will typically be configured to use NT
authentication so it is worth checking to ensure that the correct account information is given when logging in
from Crystal Reports.
Microsoft SQL Server 2005 Analysis Services
Due to timing of product release dates, Crystal Reports XI was not tested with Microsoft SQL Server 2005
Analysis Services. The changes made to connectivity drivers for MS SQL Server 2005 Analysis Services are
significant and have been addressed in Crystal Reports XI Release 2. Contact your sales representative to
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obtain a copy of Crystal Reports XI Release 2. A minor product update is required for Crystal Reports XI
Release 2 to enable reporting off MS SQL Server 2005 Analysis Services. Please refer to crxir2winmhf.zip
available on the Downloads area of our web site.
Hyperion Essbase
Differences between Hyperion servers and clients are significant. Crystal Reports can not report on all
Hyperion clients. The supported platforms document lists supported clients.
Different DLLs are used to report on different versions of the Hyperion Essbase client. SAP Note 1219811,
“Error: ‘ESSAPINU.dll could not be found in specified path’ with Essbase 6.5.4” describes steps that can be
taken to ensure the correct DLL is loaded by Crystal Reports XI Release 2.

Methods for Resolving Common Connectivity Issues
Renamed or moved databases
When a database is renamed or moved to a new folder or directory, existing reports that used an old
database name or location may give errors when refreshed. These reports can easily be adjusted to
recognize the new connection. Setting a connection to a new location or newly named database is also
useful if someone sends you a report that uses a database from a different location. See the steps below for
changing the connection under the title Using Set Datasource Location.
Tables, views, or stored procedures have been modified
When you create a new report, the report retrieves the tables and fields from the database as they are
defined at the time the report is defined. Crystal Reports uses this database structure (number of fields, field
position, data type, etc.) to identify and connect the fields that have been placed on the report.
If you change the structure of the database (by adding or deleting fields) after you create the report, Crystal
Reports needs to update the report according to the new structure of the database.
Sometimes changes to tables, views, and stored procedures can cause error messages in the reports that
run against the modified objects. The process of setting the data source to a different data source and then
setting it back to the original connection can be performed to force Crystal Reports to update itself and
recognize the changes in the table view, or stored procedure.
It is possible to switch a data source from one data source type to another type or even to the same data
source type. Sometimes this is a more reliable method to force Crystal Reports to update itself as opposed to
relying on the Verify Database feature. For example, you can change the data source location from one
ODBC DSN to another ODBC DSN. If you need to have Crystal Reports use the original datasource you may
point the connection back to the original one after the report has been updated after being set to the
temporary connection. Using the Set Datasource Location command to change to a different DSN is
required if the DSN has been re-configured with different server or authentication information.
Using Set Datasource Location
The steps for setting the datasource location are recommended if you suspect something in the database
has changed and you want to ensure that the report recognizes the most current database structure. These
steps are also recommended in the event that you need to test with a different driver to determine if your
connection issue is not driver specific.
1. Navigate to the Set Datasource Location option under the Database menu.
2. Select the Set Datasource Location on Next Refresh check box in the Set Datasource Location
dialog box.
3. The Current Datasource will appear in the top of the Set Datasource Location dialog box. In the
Replace With section at the bottom of the Set Datasource Location dialog box, create a new
connection by choosing the connection type and enter the new authentication information.
4. Select one of the tables, views, or stored procedures under the Current Datasource. Select the
corresponding object under Replace With. Click the Update button. Repeat this step for each
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individual table, view, or stored procedure on the report. Subreport connections will need to be
updated separately and may use a different connection type than the parent report if preferred.
The From: line indicates the type of connection that the report is currently using. The To: line has a pulldown menu with a list of drivers from which to select if you want to change the type of connection that the
report is using.
Note: The Map Fields dialog box appears if changes have been made to the fields in the report database. Mapping
fields is required to link the report fields to the correct database field.
For more information on how to map fields, refer to the Crystal Reports Online Help. From the Help menu in CR,
click Crystal Reports Help (or press the F1 key) and type "Map Fields dialog box”.

How to use the Verify Database command in CR
To a lesser extent, you may be able to use the Verify Database option to update the database references in
your report. This is the easiest method to update the report when there are minimal changes to the database.
Here are the steps to update the report:
1. In Crystal Reports, open the file in Design mode.
2. Click Verify Database from the Database menu. A dialog box appears asking you whether you want
to verify all the files in the report including those that are not being used.
3. Click either Yes or No.
•

Click Yes to verify all the files in the report, used or unused.

•

Click No to verify only those files used in the report.

You are then prompted with “The database file ([filename]) has changed. Proceed to fix up the report?”
•

If you click Yes, the program revises the report to the current version of the database.

•

If you click No, the program attempts to print the report without first adapting it to the current version
of the database. Verify only those files used in the report.

Command object connections need to be updated
In earlier versions of Crystal Reports, the new command must be added to the repository. SAP Note
1216209, “How to set the database location from multiple tables to a command object” describes how to set
the datasource for Crystal Reports 9. SAP Note 1218228, "How to change the connection of a command
object in Crystal Reports 10" describes a more direct method for resetting the datasource for Crystal Reports
10 and later.
Missing tables, views, or stored procedures
You may discover missing tables, views, or stored procedures in the database expert or you may receive a
message, “No Items Found” for the following reasons:
•

The display options for Data Explorer are set incorrectly.

•

The appropriate database permissions to view tables, views, system tables, synonyms and/or stored
procedures have not been assigned to your logon information.

•

The NTablesMax registry setting is too low. This setting regulates the total number of database
objects that are visible to the user and occasionally will be too low for database deployments like
Oracle.
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How to set the display options in Data Explorer
1. Select the Options button in Data Explorer.
2. Select the check boxes under the Show: options according to the data that you want to
report off. For example: Tables, Views, System Tables, Synonyms, and Stored Procedures.
3. Click OK to exit the Options dialog box.
4. To see the list of data options, collapse and re-select the folder representing your connection
selection.
The message, “No items found”, should now be replaced with a list of your data options.
Tip: In Data Explorer, select the Options button and place the cursor in the field box to ensure that there are no
unintentional spaces or unwanted text in the “Table Name LIKE:” or “Owner LIKE:” fields.

How to verify that your logon information has the appropriate database permissions to view the table, view or
stored procedure.
Attempt to create your report using a different logon. We recommend that you attempt to use the
Administrator logon information. Usually, the Administrator logon information has the highest level of
database permissions.
Note: Contact your Database Administrator to verify that your logon information has the appropriate database
permissions to allow you to connect to the tables, views, system tables, synonyms and/or stored procedures.

How to ensure your client computer is able to retrieve all available tables, views, and stored procedures
using the NTablesMax setting.
The NTablesMax setting regulates the total number of database objects that are visible to the user. A
reasonable maximum reduces the time required to list objects whenever a connection is made from Crystal
Reports. For databases like Oracle, many objects are automatically generated when other user defined
objects are created in a schema. Occasionally, the total permitted visible objects is below the total objects in
the database or schema. The result from this is that some stored procedures, views, and tables are not
visible. In this situation, the issue can be corrected by adjusting the NTablesMax setting in the registry. Using
regedit, navigate to the key:
•

Crystal Reports XI
HKEY_CURRENT_USER\Software\Business Objects\Suite 11.0\Crystal Reports\FetchOptions

•

Crystal Reports XI Release 2
HKEY_CURRENT_USER\Software\Business Objects\Suite 11.5\Crystal Reports\FetchOptions

Right-click the NTablesMax key and click Modify. Change the value from decimal 8000 to 50,000. If this
fails, you may consider trying a larger value for total objects displayed.
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Reports no longer open properly
Your existing report may no longer open successfully because the ODBC data source is corrupt.
How to correct a corrupt ODBC data source
1. In the ODBC Data Source Administrator, create a new DSN (Data Source Name). Be sure to use a
different name to force Crystal Reports to update itself against the database.
2. In the Crystal Reports designer, complete the Set Datasource Location command. Refer to the
Using Set Datasource Location section of this document for information on how to use the Set
Datasource Location command.
3. In the Crystal Reports designer, complete the Verify Database command. Refer to the How to use
the Verify Database command in CR section of this document for information on how to use the
Verify Database command.
Note: If there are subreports in the main report, complete the Set Datasource Location and Verify Database
commands for each of the subreports.
Caution: If your report fails to connect to its data source at runtime, then verify that the report connects successfully in
the Crystal Reports (CR) designer. If a report fails to connect in the CR designer, it will always fail to connect at
runtime. Continue to troubleshoot the database connection issue first in the CR designer.

1157 and 126 ODBC Errors
Refer to SAP Note 1211060, "Troubleshooting 1157 and 126 ODBC Errors".
Join Errors
Additional errors can occur due to linking within the report. This may be due to linking that is not permitted by
the database or by linking that does not generate the desired results. For troubleshooting linking in complex
reports, remove as many tables as possible to focus on the key tables and fields. If possible, remove half of
the fields and formulas and run the report. If the report still fails, halve the fields and formulas again. Repeat
these steps until the break point is found.
You may also consider using subreports to reduce the complexity of the linking.
Links can be adjusted manually on the Links tab of the Database Expert dialog that can be launched from
the Database menu.
For information on left outer join errors, please refer to SAP Note 1212698, "How to resolve join syntax errors
in Crystal Reports".
Report Migration Issues
Connectivity issues may arise from migrations of Crystal Reports from earlier versions of the product to XI.
The Connectivity changes from Crystal Reports 8.5 to XI article summarizes changes and suggests practices
for successful migrations.
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Business View Connectivity
Since Crystal Reports 10, it is possible to create reports off Business Views to bundle collections of tables,
views, and procedures and select fields from them along with an assortment enterprise permissions and
filters. Business views use the same database drivers as Crystal Reports so most of the methods to
troubleshoot Crystal Reports data connections also apply when troubleshooting connectivity from Business
Views. However, business view connectivity troubleshooting should also consider
•

business view security

•

BusinessObjects Enterprise issues

•

linking and filtering from within the foundation and element.

Data Connection or Driver Issues
Business views use the same database drivers as Crystal Reports so most of the methods to troubleshoot
Crystal Reports data connections also apply when troubleshooting connectivity from Business Views.
To determine if the issue is specific to the data connection, create a one-field Crystal Report directly off one
of the tables that is referenced in the business view. Create the connection from Crystal Reports using the
same connection type as the one that is used in the business view. If the direct connection to the database
fails this suggests that there is an issue with the connection. In this case, methods for troubleshooting the
connection explained above would apply.
You may also try creating a one-field report off the same business view that fails in the original report. This
will help to determine if the connection is failing because of the business view connection or because of
something in the view or report itself.
Business View Security
Business view security can be applied at many different levels. Security settings can be issued for the
connection, the foundation, the element, the view, or even a specific field or filter. These possibilities may
seem overwhelming at first but there are troubleshooting methods that can quickly help to focus on the most
important areas.
An Enterprise user may belong to many groups and may even have their own user-specific security settings.
A user who belongs to multiple groups will be restricted to the group setting that has the least privilege for
accessing each object. If the user belongs to the Administrator group but is not the named Administrator,
they must be explicitly granted access in at least one of the groups and they must not be denied access in
any of their groups.
Here are some suggestions to determine if security is an issue. Log in to Business View Manager using the
affected person’s account to check the following:
Check the Data Access Rights for the Connection
Denied data access for any of the user’s groups will prevent the user from seeing any data from the business
view in Crystal Reports even if the user has view rights. When in Business View Manager, to check the data
access permissions, right click the data connection and choose Edit Rights. In the Edit Rights dialog that
appears, if any groups for the affected user are missing be sure to add them to the list using the Add
Groups button. Select Preview and examine the Data Access column. If any of the user’s groups have
been denied data access rights this user will not be able to view business view data in Crystal Reports. If the
user is not the named Administrator explicitly grant data access for at least one group.
Check the View Rights for the Business View
If view rights for the business view are denied for any of the user’s groups this user will not be able to see
data from the business view in Crystal Reports. To check the user’s view rights, right-click the business view
in the Repository Explorer and click Edit Rights. All of the user’s groups must be visible to successfully
determine accessibility. If any of the user’s groups are missing they must be added by selecting the Add
Groups button. Once all of the user’s groups are listed, select the Preview button so see the view privileges.
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Ensure the View setting is not explicitly denied for any of the groups otherwise this user will not be able to
view data from the business view in Crystal Reports.
Narrow the focus to one field and troubleshoot it
Sometimes focusing on one field in the business view and examining it more closely can help to simplify the
search for security issues when investigating the connection, foundation, element, and view. It is possible
that the view rights for individual fields are denied. To ensure that the individual fields are not denied, open
the business element that contains the field, right click the field and choose Edit Rights.
Be sure that all groups for the user are present and that none is denied view rights. If any of the user’s
groups have been denied the user will not be able to see data for this field in Crystal Reports. Once it
appears that the field has view permissions for all of the user’s groups, try creating a one field Crystal Report
based on a field from this business view to see if any data is returned. If data is returned, you may consider
examining linking within the foundation or filters that might be preventing data retrieval as explained below.
Check the Data Filters
Filters can be applied at the foundation and element level of the business view which can affect data view
access. Filters can be examined in Object Explorer at both the foundation and element level within
Business View Manager. To determine if any of the user’s groups have been restricted by a filter, right click
the filter and preview the settings for Applied or Not Applied to ensure that none adversely affects the
expected data.
BusinessObjects Enterprise Server Issues
Business Views are hosted on the BusinessObjects Enterprise server which also regulates authentication.
You can test the servers with the repository samples that can be installed from Business View Manager. In
Business View Manager click Tools and choose Install Repository Samples. Create a report using the
Xtreme business view that is included with the samples. If this report gives the same error as your original
report then there is a possibility the problem is occurring with the server configuration.
Linking in the Foundation
Complex foundations can be difficult to troubleshoot even for the most experienced business view users. To
help simplify this task, if linking is suspected to be incorrect try creating a simplified foundation that contains
the fewest possible key tables, views, and stored procedures. Then create one element with all fields from
this foundation. Then create a business view off this element. Finally, create a one field Crystal Report off
this test business view and examine the SQL from the database menu under Show SQL Query. If this report
does not return the expected data you might consider adjusting the links in the foundation.
If tables are left unlinked in the foundation, you may get Cartesian joins (infinite loops). For this reason,
including unlinked objects in the foundation is strongly discouraged.

Dynamic Cascading Parameters
Dynamic cascading parameters build on business view troubleshooting steps which in turn may also require
connectivity troubleshooting for different types of data connections. Even so, there are additional parameter
specific methods that can be applied to help identify the connection problem. Below are some additional
suggestions for troubleshooting List of Values (LOV) specific issues.

SAP COMMUNITY NETWORK
© 2009 SAP AG

SDN - sdn.sap.com | BPX - bpx.sap.com | BOC - boc.sap.com
12

Troubleshooting Database Connectivity for Crystal Reports

Test the List of Values Feature with the Xtreme Sample
If the problem occurs with a list of values that has been created in Business View Manager, try creating a
simple list of values with the Xtreme business view sample that is installed with the repository samples.
These samples can be installed in Business View Manager from the Tools menu. Then create a blank
Crystal Report and add the dynamic parameter based on the Xtreme list of values. Place the parameter in
the report header and run the report. If the report fails with the same error, this suggests there could be a
configuration issue on the client or server.
If the list of values is created in the report, try creating a simple report using the Xtreme database sample. A
DSN for Xtreme is created when Crystal Reports is installed. In a report off the Xtreme database, create a list
of values off one of the tables that is accessible from the Xtreme connection. If this fails, there may be an
issue with the Crystal Reports configuration.
Simplify the Foundation, Element, and Business View used to Build the List of Values
Simplifying the foundation and element used in the list of values can help to identify if there are issues with
filtering or linking that might prevent proper record retrieval in the prompt.
Test Scheduled Versus Non-Scheduled Lists of Values
Using a simple list of values, test it as a scheduled and non-scheduled parameter in Crystal Reports. On
demand lists of values use the report application server. Be sure that all servers are enabled and are working
properly.
Truncation of Records Retrieved by the List of Values
If the data in the list of values is truncated you may try the steps outlined in SAP Note 1218573, "The Query
Panel List of Values has a maximum limit of 1000 values" and SAP Note 1218588, "How to increase the
number of values in a dynamic parameter list?”.
If this fails to produce results for on demand lists of values, you may consider adjusting the batch size in the
RAS server from the Central Management Console of BusinessObjects Enterprise XI.

Universe Connectivity
When troubleshooting connectivity issues with Universes, it is possible that the issue resides within the
Universe. This section presents items that can be investigated in Designer and in Crystal Reports.
Troubleshooting the Data Drivers
Most Universe connections are created from drivers that are native to Designer. For these drivers to work
properly, the database client must be installed on
•

the client where Crystal Reports runs

•

the BusinessObjects Enterprise server.

To ensure that the version of your database client and server are supported, please view the supported
platforms document.
After verifying that the database client is installed on both the client computer and server, and the connection
is still not possible, try creating a one field report off the Universe on both the client and BusinessObjects
Server to see if the connection works there. If this one field Crystal report against the Universe works on the
client where Crystal Reports runs but the original report fails, this test verifies that the connection is fine and
suggests that there could be an issue with either one or the following:
•

the Universe joins or structure

•

filters within the Universe

•

the original Crystal Report design.
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If the one field report off the Universe runs on the server only this suggests there could be an issue with the
connection on the client. If the one field report fails on both the client and enterprise server this suggests
there is a problem with the data connection on both computers.
If the database client and server do not appear on the supported platforms guide you may consider changing
the datasource in the Universe to an ODBC connection for further testing.
Changing the Connection to ODBC
If you suspect the native driver is not working properly, try creating a DSN using the database client’s ODBC
driver, if one is available. You can change the connection in the Universe to use the generic ODBC
datasource which will allow you to select the DSN as the datasource for your Universe. The Universe
connection can be changed under the File menu by clicking Parameters and choosing the Edit button on
the Definition tab of the Universe Parameters dialog. An identical DSN must be set on
•

the client where Crystal Reports runs

•

the BusinessObjects Enterprise server.

If a Universe that uses the ODBC connection appears to work then the issue is driver specific. Check the
supported platforms guide to ensure that the database being used is supported.
Examining the SQL Syntax
If the connection appears to succeed but the record retrieval does not function as expected, you may
consider examining the SQL syntax. The SQL for the query can be obtained from the original Crystal Report
under the Database menu by clicking Show SQL Query. This SQL can be copied and tested in the
database client on the same computer as Crystal Reports to determine if the record retrieval is possible and
if it returns records as expected. If the database client returns the correct record set and Crystal Reports
does not, try running the same SQL query in SQLCON32 as described in the section on ODBC connections
section of this document.
Running the query in SQLCON32 provides an unbiased test for querying the database through a third-party
application. If the SQLCON32 utility returns the data as expected, it does suggest there could be a problem
with the Universe linking, structure, filters, or with the report design. If SQLCON32 does not return the data
as expected it suggests there could be a problem with the query syntax or with permissions at the database
level.
Changing Filters in Designer
It is possible that filters exist in the Universe that may prevent the user from retrieving data. These filters can
be viewed from Designer from the Tools menu and selecting Manage Security. You can also try running the
report against the Universe while logged in with a different user account that has more access permissions.
Changing Rights to View the Universe
If you suspect there are BusinessObjects Enterprise rights issues with accessing the Universe, you could
examine the individual rights for this Universe by logging into the Central Management Console (CMC) and
selecting Universes. In the Universes page, select the Universe being used in troubleshooting. For this
Universe, access the Rights tab and examine the rights for each of the user’s groups to ensure they have
proper view access for all groups in which they belong.
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Related Contents
For more information, visit the Business Objects homepage.
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